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Chapter 1
CentreWare Printer Drivers for Microsoft Windows

CentreWare is software that brings the power of your Xerox systems to your desktop. The interactive 
drivers on CentreWare make printing from the desktop simple to perform and easy to understand.
With this guide, administrators can install and configure CentreWare printer drivers and general users 
can increase their productivity using the Xerox system’s printing options.

What’s in this chapter:

What’s Included in this Release? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-2
Printer Driver Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-3
Types of CentreWare Printer Drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-3
Obtaining CentreWare Drivers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-4
Xerox System PPD Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-4
CentreWare Printer Driver Applications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-5
Print and Fax Driver Documentation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-6
Internet Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-7
Telephone Support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-7
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What’s Included in this Release?
The CentreWare 7.2 release of the WorkCentre printer drivers supports the following new features  
and / or hardware.

PostScript and PCL drivers for the following models:
WorkCentre 7328
WorkCentre 7335
WorkCentre 7345

New user interface
Hole punch capability: 2/4 or 3 hole punch
Save to Mailbox feature
Finishing capabilities (optional on some models). Finishing options may include: Stapling, Hole 
Punching, Folding, Booklet Creation, and Offsetting. Features vary based on the finishing unit.
Feature Facts and Feature Finder quick reference cards describe selected printing options and where 
to locate them in the printer drivers.
Bi-Directional printer drivers that automatically configure the driver with the installable options, 
report the system’s current status, provide information on active jobs, and a history of the last 
twenty-five jobs on your Xerox system.
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Printer Driver Overview
A printer driver makes documents created with specialized software applications (word processing, 
spreadsheets, graphics) compatible with a specific printer. Each type of printer requires unique 
commands to print correctly and to enable special features. For these reasons, different types of printers 
require their own printer drivers to operate correctly. 
With CentreWare printer drivers, you can print from your workstation to a Xerox system in a network 
environment. CentreWare drivers contain a variety of feature options that you can use to customize your 
print jobs. 

Types of CentreWare Printer Drivers
The CentreWare printer drivers are available in PostScript, PCL5c, and PCL6c printing formats.

PostScript
PostScript gives you greater ability to scale and manipulate images; it offers more precision with 
high-end graphics. PostScript also provides you with different types of error-handling and font 
substitution options. 

PCL
PCL (Printer Command Language) generally has fewer advanced features than PostScript. However, 
using PCL enables you to process most jobs faster.
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Obtaining CentreWare Drivers
CentreWare Print and Fax Drivers CD
The installation .inf files for the Xerox system printer drivers are available on the CentreWare Print and 
Fax Drivers CD. 

For updates and additional information, visit the Xerox Web site.

Downloading from the Web
CentreWare printer drivers can be downloaded from the Xerox Web site at www.xerox.com. The 
installation files for all Xerox system models are also available from the Web site.
For more information on downloading drivers, see Step 1 on page 2-4.

Xerox System PPD Files
A PostScript Printer Description (PPD) file is a readable text file that provides a uniform approach to 
specifying special features for printer drivers that interpret PostScript. 
Xerox provides PostScript PPDs for use with generic Windows 2000 / XP / Server 2003 / Vista 
PostScript printer drivers. These PPDs are available on the CentreWare CD or from the Xerox Web site.

NOTE: Driver availability may vary by printer model or operating system.
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CentreWare Printer Driver Applications
The following applications are included on the CentreWare Print and Fax Drivers CD:

Xerox Print Driver Installation utility
TIFF Submission Tool 
Xerox Font Management Utility

Xerox Printer Driver Installation Utility
This utility is for anyone who would like to install printer drivers directly onto a PC or network server. 

TIFF Submission Tool
With the TIFF Submission Tool, you can submit TIFF (Tagged Image File Format) files directly to a 
Xerox system for printing. TIFF files print faster when they are sent to the Xerox system in this format. 

See Installing the TIFF Submission Tool on page 5-1 for more information.

 Xerox Font Management Utility
The Xerox Font Management Utility is a tool used for managing fonts and printer lists. Fonts may be 
viewed, printed, or downloaded to printers, and your downloaded (non-resident) fonts can be exported to 
a file. Printers can be added or deleted from a printer list which is used for adding and deleting fonts 
from one or multiple printers. 
See Installing the Xerox Font Management Utility on page 4-2 for more information.

NOTE: You may require administrator rights to perform the installation.

NOTE: You must have a TIFF interpreter on your Xerox system to use this tool.
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Print and Fax Driver Documentation
The CentreWare printer drivers include the following documentation to get you up and running quickly 
and easily. 

CentreWare Printer Drivers Guide for Windows (This guide)
This guide is intended for anyone who installs and configures CentreWare printer drivers and wants to 
know more about the features available in the printer drivers.
The CentreWare Printer Drivers Guide is available on the CentreWare Print and Fax Drivers CD in 
electronic (PDF) format. You can download a free Adobe Acrobat Reader from Adobe at 
www.adobe.com.

Help
The Help system is the primary source for information about using the printer drivers. You can 
access the Help system through the Help buttons in the driver. Included in the Help system are 
feature descriptions, step-by-step procedures, Xerox system information, problem-solving 
information, and support information. 

Quick Reference Cards for Printer Drivers
Included in this guide are Quick Reference Cards for printer drivers:

Feature Finder Card - Two Quick Reference cards, one for PostScript and one for PCL, help 
you locate the many printing options available through the printer driver to make printing 
easier. 
Feature Facts Card - This single Quick Reference card describes selected printing options, 
such as Watermarks, Booklet Layout, and Stapling. 

Xerox Desktop Scanning User Guide (Windows)
This guide provides installation and configuration instructions for the WIA and TWAIN drivers as well 
as information on using the Xerox Scan Utility to retrieve images.
The Xerox Desktop Scanning User Guide is available in the Documentation folder on the CentreWare 
Print and Fax Drivers CD.
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Support
Support for your CentreWare printer drivers is available both online and by telephone.

Internet Support
Please visit the Xerox Web site (www.xerox.com) for product support information, product overviews, 
updates, and links to specific product sites. Printer drivers and PPDs can also be downloaded by clicking 
Support & Drivers. 

Telephone Support
For additional assistance, you may contact the Xerox Welcome Center by telephone to speak with a 
Product Support Analyst. Locate your Xerox system serial number, and record it in the space below 
before you make your call.

The Xerox Welcome Center telephone numbers are listed in the following table. If the Welcome Center 
telephone number for your country is not listed, it will be provided to you when your Xerox system is 
installed. For future reference, please record the telephone number in the space provided below. 

Additional Tips
Additional tips and technical information for printer drivers are available at the Xerox Web site. Click 
Support & Drivers, identify your product, and click the Documentation link. The documents listed in 
this section cover specific issues that may require special procedures or application notes regarding the 
operation and configuration of your Xerox system.

Xerox System Serial Number:

Welcome Center Telephone Numbers:

UNITED STATES 800-821-2797

UNITED STATES (TTY) 800-855-2880

CANADA 800-939-3769 (800-93-XEROX)

OTHER
Support 1-7

http://www.xerox.com


1-8 CentreWare Printer Drivers for Microsoft Windows



Chapter 2
Installing Windows Printer Drivers

The CentreWare printer drivers support the special features and functions of Xerox systems, enabling 
fast, efficient printing from your desktop. This chapter provides installation instructions for all current 
Windows environments.

What’s in this chapter:

Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2
Installing Printer Drivers on Windows Networks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-3
Direct Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-4
Considerations for Enterprise Technologies  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-7
Point and Print Installations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-9
Installing Printer Drivers on Other Networks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-9
Configuring Printer Drivers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-10
Configuring Installable Options at the Workstation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-10
About Bi-Directional Printer Drivers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-14
Uninstalling Windows Printer Drivers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-16
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Requirements
Printer Drivers
The Xerox printer drivers require:

A maximum of 32 MB of available hard disk space per CentreWare Windows printer driver.
Internet Explorer 5.5 or higher installed on the workstation for Windows 2000, XP, Server 2003, or 
Vista drivers.

Xerox Printer Driver Installation Utility
The Xerox Printer Driver Installation Utility requires:

Administrator privileges in Windows 2000 / XP / Server 2003 / Vista.
Internet Explorer 5.5 or higher.
Service Pack 2 installed on Windows XP systems.
Service Pack 4 installed on Windows 2000 systems.
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Installing Printer Drivers on Windows Networks
In Windows environments, you can install a Xerox printer driver by using a direct installation, a custom 
installation, or a Point and Print installation.

Direct Installation
Use the Xerox Printer Driver Installation utility to install Xerox printer drivers for your network printers 
quickly and easily. If you have the CentreWare Print and Fax Services CD or know the network location 
where the contents of the CD have been saved, you need only run the installer once per Xerox system to 
install the drivers for multiple page description languages (PDLs) directly onto a PC or print server. 

Point and Print Installation
Copy the contents of the CentreWare Print and Fax Services CD to your network. Install the drivers 
locally and modify the device settings and document settings. Then copy the new configurations to the 
server for enterprise use (see Point and Print Installations on page 2-9).

NOTE: You can use the Add Printer Wizard to install Xerox printer drivers, but you must install each 
driver separately.

NOTE: It is possible to upgrade a Windows driver without uninstalling the previous version. However, 
the impact of such an upgrade on system performance can be unpredictable. The most reliable way 
to upgrade is to uninstall the old drivers and perform a clean installation of the new ones. For 
information on uninstalling drivers, see Uninstalling Windows Printer Drivers on page 2-16.
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Direct Installation
You can install the CentreWare printer drivers from the CD, from network location, from a URL, or 
intranet address.

To install Windows printer drivers:
1 Do one of the following:

2 Double-click install.exe. The AutoRun program displays the available selections.

3 Click Install Drivers.

4 An administrator may have created a screen containing customized instructions for the site. If such a 
screen appears, record and follow any posted instructions. Then click Next.

5 The installer scans supported direct connections as well as the local network subnet for printers. The 
results appear on the Select Printer screen.
 Do one of the following:

If the printer that you want to install appears in the list of discovered printers, click Select From 
the Following Discovered Printers and select the printer.
If the printer does not appear in the list of discovered printers, do one of the following:

NOTE: After you start the installer, it detects the operating system of the server or workstation. If that 
operating system does not meet the product requirements, the installer issues a message and exits. 
This behavior would occur, for example, if you attempted to install drivers housed on a Windows 2000 
server onto a client running Windows 3.1.

If installing from: Then:

CD-ROM Insert the CentreWare Print and Fax Drivers CD into the CD-ROM drive. The 
AutoRun program displays the available selections. Continue with Step 3.
–or–
If the AutoRun is disabled on the workstation, open My Computer and 
double-click the CD-ROM drive. 

Internet a) Open a browser window and access www.xerox.com.

b) Click Support & Drivers.

c) Identify your product.

d) Click Drivers and Downloads under the printer model.

e) Choose the desired operating system and language, then click Go. The 
available driver options are updated.

f) From the list of drivers, click the appropriate driver to download.

g) Read the End User License Agreement and click Accept.

h) Click Save from the File Download dialog.

i) Choose a location to download the file and click Save.

intranet Open a browser window and type the appropriate intranet address, such as 
http://xyz.mycompany.com.

network location Use Windows Explorer to find the CentreWare installation files.
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Click Advanced Search and choose an automatic or manual search method. 

After making your selections, click Search.
Choose Enter Printer’s IP address, DNS name, or UNC path. Enter the information or 
browse for one of those identifiers. 

6 Click Options to configure any of the following settings:

Language - Select the language in which to run the installer.
Driver Selection (PDL) - Choose at least one of the following PDLs: PostScript, PCL5c, or 
PCL6c. The PostScript driver is the default selection. For more information on driver selection, 
see Types of CentreWare Printer Drivers on page 1-3. 

Driver Settings - Select any of the following options: 
Share the printer on the network (requires Windows 2000 / XP / Server 2003 / Vista).
Convert the printer’s DNS name to an IP address.
Set the printer as your Windows default.

7 Click OK to exit Options.

Search Action

Automatic The installer detects and searches for all printers on all available subnets.

Manual Enter the gateway and subnet mask for the search directly,

–or–
Use Previous Search. Select a search that the installer has previously 
performed from a drop-down list.

NOTE: Examples of printers that may not appear on the discovered printers list or search results, 
regardless of operating system, include printers connected to a different subnet or printers on a 
print queue.
Using the discovered printers list, IP address, or DNS name to identify the printer results in the 
creation of a local print queue, while using the UNC name associates the printer with an existing 
queue.
If you enter an invalid IP address or device discovery fails, the Select Printer Configuration dialog 
appears and enables you to choose the correct driver to install from the list of supported printers.

NOTE: This setting does not impact installation of a printer that is assigned to a network queue.
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8 Click Install. The installer copies the driver files, edits the registry, and adds the printer to the 
workstation or server.

9 The Installation Complete screen appears to report a successful installation. Do any of the following:

Click Set Contact/Location to enter, review, or edit the Printer Administrator Name, Printer 
Administrator Phone Number, Printer Administrator Location, and Printer Location.
Click the support link to learn about using the printer.

10 Click Finish to end the installation.

NOTE: If you do not have sufficient rights to install a printer on the designated server, a logon 
prompt will appear. Enter a valid user name and password to continue the installation.

NOTE: If the installation fails, an Installation Failed window, with applicable error messages and 
suggestions, appears. Click Close to end the installation attempt.
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Considerations for Enterprise Technologies
Large organizations, or organizations with specialized requirements for security, reliability, or remote 
access frequently employ technologies that impact the installation process. This section briefly describes 
two technologies that CentreWare printer drivers support—clusters and Citrix MetaFrame—and the role 
of the Add Printer Driver Wizard in preparing these environments for successful printer definition.

Clustering
Clustering is a technology that configures two or more servers ("nodes") to behave as one. Each node has 
access to a storage medium (the "cluster") that houses the supported application or data. 
Clustering is usually employed to improve fault tolerance or to implement load balancing. Typical 
applications of clustering are applications or functions that require virtually uninterrupted service, such 
as production report generation in many manufacturing environments, where one server failure could 
have repercussions throughout the supply chain. 
Print servers are one of many possible applications of clustering. Others include Web services, ftp 
services, file management, and even managing some aspects of Active Directory.
When a cluster houses a print server, only the print spooler folder resides on the cluster. The printer 
drivers reside on the nodes in their standard locations. When one node fails, printing continues using the 
drivers that are present on a surviving node. Should that node lack the appropriate drivers, consequences 
range from a lack of access to advanced driver features to a complete inability to print.
Use the Add Printer Driver Wizard (see Add Printer Driver Wizard on page 2-8) to install the printer 
drivers in a cluster.

Citrix MetaFrame
Citrix MetaFrame provides centralized application management and distribution to an enterprise. 
Applications that are published to users from a Citrix server have a single point of installation and 
maintenance, simplifying administration. Desktop hosting capabilities offer access to current operating 
platforms and applications to users running a wide range of hardware and operating systems, while 
providing administrators increased control.
A Citrix server can be configured to "auto-create" a printer or printers when a Windows client logs in. 
This procedure makes the client’s Windows printers available within a Citrix session. If the appropriate 
drivers do not reside on the Citrix server, the Citrix server substitutes a "universal" driver. The user can 
still print, but many of the features associated with CentreWare printer drivers, such as accounting or 
booklet creation, are unavailable. 
To prevent this, install the CentreWare drivers (See Add Printer Driver Wizard on page 2-8) on a Citrix 
server (or on all members of a Citrix server farm) before clients that use local printers based on these 
drivers log in.

NOTE: The driver name (string) on the clients must match up with the driver name (string) on the 
Citrix server in order for the printer driver to auto-create correctly during a Citrix session. If they do not 
match, the user will get a "universal" driver with limited features.
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Add Printer Driver Wizard
This wizard loads the requested drivers on a Windows print server but does not create a queue or printer 
object. 

To run the Add Printer Driver Wizard:
1 Using the appropriate path for your operating system, locate the list of printers:

Windows 2000 - Start > Settings > Printers
Windows XP - Start > Printers and Faxes
Windows Vista - Start button > Control Panel > Hardware and Sound > Printers 

The Printers or Printers and Faxes window appears. 

2 Click File > Server Properties. The Print Server Properties dialog box appears.

3 Click the Drivers tab.

4 Click Add. The Add Printer Driver Wizard appears. 

5 Follow the instructions on the screen.
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Point and Print Installations
This procedure assumes that a Xerox system on a network server has been installed with the appropriate 
CentreWare printer driver prior to performing Point and Print. 

To perform Point and Print:
1 At the client workstation, access the desired network Xerox system through My Network Places 

(Network in Windows Vista). Browse to the printer.

2 Do one of the following: 

Double-click the Xerox system icon. At the prompt, select to install the printer driver. 
–or–

Right-click the Xerox system icon. At the prompt, select to install the printer driver. 
–or–

Click the Xerox system icon. Drag and drop the printer icon on the Printers folder. 
The Add Printer Wizard opens.

3 Follow the Add Printer Wizard instructions. The appropriate files for the selected Xerox system 
download to the client workstation.

Installing Printer Drivers on Other Networks
The Xerox Printer Driver Installation utility supports Windows networks. To install drivers in other 
networks, follow the network operating system’s procedures for creating print servers, printers, and 
queues. You may then be able to use Microsoft’s Add Printer Wizard to install drivers on Windows 
clients and attach the clients to queues.
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Configuring Printer Drivers
To use the CentreWare printer drivers most effectively, configure the drivers to reflect options available 
on the Xerox system. You can configure the drivers in one of the following ways:

Preconfigure standard device and document settings in the driver prior to distributing them for 
installation. 
Configure installable options directly at a workstation.

Configuring Installable Options at the Workstation
You may want to configure installable options directly at a workstation. You may be able to configure 
the driver settings automatically, using the driver’s Bi-Directional communication functionality, or make 
the selections manually, setting the options on the individual driver dialogs.

Configuring Installable Options Automatically
If you have a TCP/IP network, the Windows printer drivers can, as an option, provide Bi-Directional 
capabilities. The printer driver communicates with the printer through your network and acquires 
information from the printer. See About Bi-Directional Printer Drivers on page 2-14.

To configure the Installable Options automatically:
1 Using the appropriate path for your operating system, locate the list of printers:

Windows 2000 - Start > Settings > Printers
Windows XP - Start > Printers and Faxes
Windows Vista - Start button > Control Panel > Hardware and Sound > Printers 
The Printers or Printers and Faxes window appears. 

NOTE: You may need administrator rights on the workstation to perform these steps.
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2 Right-click the appropriate printer icon and select Properties.Select the Configuration tab. 

3 Click Bi-Directional Setup. The Bi-Directional Communication dialog opens.

Figure 2-1:  Configuration Tab (Properties Dialog)

Figure 2-2:  Bi-Directional Communication Dialog
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4 Enter the Device Name or TCP/IP address.

5 Select On to enable Bi-Directional communication.

6 Click OK. Bi-Directional communication is enabled. A Status button appears on the Paper/Output 
tab of the printer driver. By clicking Status, you can access current information about the printer. See 
About Bi-Directional Printer Drivers on page 2-14. 

Configuring Installable Options Manually
If your network environment does not support Bi-Directional communication, you can configure 
installable options manually. See Bi-Directional Driver Support on page 2-15 to see if your network 
environment is supported.

To configure the Installable Options manually:
1 Using the appropriate path for your operating system, locate the list of printers:

Windows 2000 - Start > Settings > Printers
Windows XP - Start > Printers and Faxes
Windows Vista - Start button > Control Panel > Hardware and Sound > Printers 

The Printers or Printers and Faxes window appears.

2 Right-click the appropriate printer icon and select Properties.

3 Select the Configuration tab. 

NOTE: To change the SNMP Community Name, click SNMP Community Name. The printer 
name must be changed to match this name for Bi-Directional communication to be available.

Figure 2-3:  Configuration Tab (Properties Dialog)
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4 Click Installable Options and select the options that are available on your Xerox system.

Figure 2-4:  Installable Options Dialog

5 Click OK twice to save the Installable Options settings and close the Properties dialog.

6 Close the Printers and Faxes window.
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About Bi-Directional Printer Drivers
With Bi-Directional communication, a printer driver communicates with the printer through the network. 
The Windows 2000 / XP / Server 2003 / Vista printer drivers can provide Bi-Directional capabilities for 
TCP/IP networks. 
After an initial setup procedure, Bi-Directional communication automatically updates the printer driver 
with the printer’s installed options and reports specific information about the printer’s operational status, 
active jobs, completed jobs, and paper status in your Xerox system. 

Status Dialog
The Status dialog shows the status of the Xerox system as well as specific information about its print 
jobs. Check the status of up to 25 jobs currently in the print queue or verify the status of completed jobs. 
Use this dialog to check the properties of the paper loaded in different paper trays on your printer and 
also the current paper levels in those trays. You can also use this dialog to verify that your printer is 
functioning properly.

Click More Status on the bottom of any tab window to access the Status dialog. 

NOTE: If network communication is temporarily unavailable or is not configured properly for the 
printer, the network, or your workstation, the Bi-Directional information does not appear.

Figure 2-5:  Status Dialog - Consumables Tab
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Bi-Directional Driver Support

Supported Operating Systems
Bi-Directional drivers are supported for the following Microsoft Operating Systems:

Client-Based Implementations
Bi-Directional drivers installed on a client workstation communicate with Xerox systems via the 
following methods:

Server-Based Implementations
Bi-Directional drivers installed on a server communicate with Xerox systems via SNMP over TCP/IP or 
SNMP over IPX/SPX.
The data available in server-based drivers will not update on a regular basis. When configuration 
changes are made, the driver must be reopened to detect the changes.

Windows 2000 (Professional, Server, Advanced Server)

Windows XP (Home, Professional)

Windows Server 2003 (Server, Enterprise Server)

Windows Vista (Home, Business, Enterprise, Server)

Device Settings SNMP over TCP/IP

Job Monitoring SNMP over TCP/IP

Job History SNMP over TCP/IP

Device Status SNMP over TCP/IP

Device Configuration Microsoft Point and Print functionality
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Uninstalling Windows Printer Drivers

For Windows 2000 / XP / Server 2003 / Vista

To uninstall the Windows 2000, XP, Server 2003, and Vista printer drivers:
1 Using the appropriate path for your operating system, locate the list of printers:

Windows 2000 - Start > Settings > Printers
Windows XP - Start > Printers and Faxes
Windows Vista - Start button > Control Panel > Hardware and Sound > Printers 

2 The Printers or Printers and Faxes window appears.

3 Right-click on the icon for the printer you want to delete and select Delete. 

A confirmation message appears. 

4 Click Yes to delete the printer driver object.

5 Repeat steps 2 and 3 for all printer objects that use the driver being uninstalled. For example, 
suppose you are uninstalling the PCL6c driver for a particular Xerox system. If your Printers 
window includes icons for more than one instance of that printer, you must delete them all before 
continuing.

6 Rebooting your workstation is recommended.

7 Using the appropriate path for your operating system, locate the list of printers:

Windows 2000 - Start > Settings > Printers
Windows XP - Start > Printers and Faxes
Windows Vista - Start button > Control Panel > Hardware and Sound > Printers 

The Printers or Printers and Faxes window appears.

8 Right-click in a blank area of the folder. A drop-down menu opens.

9 Select Server Properties. A Properties dialog opens.

10 Select the Drivers tab. 

11 Select the printer driver to remove.

12 Select Remove. The printer driver is deleted.

13 Reboot the workstation.

NOTE: Before you uninstall CentreWare Windows printer drivers, ensure that the Xerox system you 
are deleting is not the default printer. If so, select another printer as the default.
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Chapter 3
Printer Driver Features

With the CentreWare printer drivers, you have an invaluable tool to save time and increase your 
productivity. These drivers offer over thirty-five feature options, depending on the type of driver and the 
installable finisher options, for you to choose how your document will look and print. 
The Help system is the primary source for information about using the printer drivers. At any time, you 
can access the Help system through the Help buttons on the driver.

What’s in this chapter:

Driver Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-2
Tabs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-3
Driver Help System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-5
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Driver Structure
The driver arranges the features on the following tabs: Paper/Output, Layout/Watermark, Image 
Options, and Advanced.  

The features on the tabs are organized for your convenience with the most frequently used features 
available when you open the driver. Small icons are placed next to the features so that you can quickly 
find the features you want. By clicking on the icon you can go through the list of options for that feature. 
Or, use the drop down list to see the options.

When chosen, certain features constrain other features. When you click the information icon, a 
pop-up dialog appears explaining why the feature you chose is not available or why it is 
constrained to a particular selection.

Figure 3-1:  Printer Driver Interface
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Tabs
Features vary on the driver tabs depending on the driver type and installable options.

General Tabs
These driver tabs are accessed through the application’s print dialog. Driver setting changes on these tabs 
apply to the open document and application, and are temporary.

Paper/Output
The Paper/Output tab has the most frequently used features. For example, you can choose to print on 
two sides of the paper, select specific media on which to print, or delay your print job to a time you 
specify. The Paper/Output tab also presents the finishing options, which may include Staple, Fold, Hole 
Punch, or other options, depending on the type of finisher you have installed.

Layout/Watermark
The Layout/Watermark tab contains all features that relate to Page Layout and Watermarks. The 
Watermark Editor, which is accessed from the Watermark dialog, enables you to create and customize 
text or graphic watermarks.

Image Options
The Image Options tab groups together features that are related to image manipulation, such as Reduce/
Enlarge, Lighten/Darken, or Invert Image.

Advanced
The Advanced tab contains features that infrequently change once the options are set, such as Banner 
Sheet, Request Offset, and TrueType Font options..

Status
If you have enabled the optional Bi-Directional communication for a printer driver, a Status area is added 
to the bottom of all tab windows. When you click More Status, the Status dialog opens and reports 
specific information about the printer’s operational status as well as specific information about your print 
jobs. See Status Dialog on page 2-14.
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Default Tabs
These driver tabs are accessed through the Printers folder and may be available only with administrative 
rights. Using the appropriate path for your operating system, locate the list of printers:

Windows 2000 - Start > Settings > Printers
Windows XP - Start > Printers and Faxes
Windows Vista - Start button > Control Panel > Hardware and Sound > Printers 

The Printers or Printers and Faxes window appears. Right-click on the printer icon and select 
Properties from the menu. The printer driver dialog appears. Driver settings from this dialog become the 
default settings. All of the General Tabs from your application’s print dialog are available, as well as 
some other tabs such as the Configuration tab and the Device Settings tab.
The Configuration dialog contains several buttons (depending on your Xerox system model): Bi-
Directional Setup, Installable Options, Accounting and About. Each button opens a dialog to configure 
your driver. 

Bi-Directional Communication allows you to enable bi-directional communication. You will then 
receive information through the driver about your print job, Xerox system, and paper status. See 
About Bi-Directional Printer Drivers on page 2-14. 

Installable Options lets you manually configure the driver with the number of paper trays and 
installable options - such as finishers and faxing - available on your Xerox system. 
Accounting lets you set up the driver to use accounting features. See the Accounting topic in the 
printer driver Help for more information.
About shows the driver version number. Xerox personnel may request this number during support 
calls.

The Device Settings tab contains features that relate to font settings and PostScript settings.
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Driver Help System
The Help system is the primary source for information about using the printer drivers. Each driver tab 
has a Help button for easy access to the Help system. Through this Help button you can call up 
information on any feature on that tab or any other tab. Among the useful items in the Help system is a 
menu of How To... procedures for each feature, for example, How to print booklets, turn banner sheets 
on/off, print transparencies, or track printer use by account.
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Chapter 4
Installing the Xerox Font Management Utility 

The Xerox Font Management Utility is a tool used to maintain fonts on network printers. Font lists can 
be developed and modified for your printers. For example, if you have special fonts that are used in 
documents but are not readily available on your printer(s), use the Xerox Font Management Utility to 
download the required fonts to the printers. Using the utility, fonts may be viewed, printed, downloaded 
to printers, or your downloaded (non-resident) fonts exported to a file. You may also maintain printer 
lists for font management.   

What’s in this chapter:

Installing the Xerox Font Management Utility. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-2
Accessing the Xerox Font Management Utility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-2
Using the Xerox Font Management Utility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-2
Uninstalling the Xerox Font Management Utility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-3
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Installing the Xerox Font Management Utility
To install the utility:
1 Insert the CentreWare Print and Fax Services CD into the appropriate drive. The AutoRun program 

starts.

2 Click Tools and Utilities.

3 Click Install Font Management Utility.

4 The installation wizard opens. Click Next.

5 Select the radio button to accept the license agreement. Click Next.

6 Type the user name and organization. 

7 Specify who has access to the application. Click Next.

8 Select the Setup type: Complete or Custom. Click Next.

9 Click Install to install the utility on the workstation.

10 Click Finish to exit the install wizard.   

The installation is complete.

Accessing the Xerox Font Management Utility
To access the utility in Windows environments:

From the desktop, select Start > Programs > Xerox Font Management Utility > Font 
Management Utility in Windows 2000 or Start > All Programs > Xerox Font Management 
Utility > Font Management Utility in Windows XP / Server 2003 / Vista.

Using the Xerox Font Management Utility
The Help system is the primary source for information about using the Xerox Font Management Utility. 
You can access the Help system through the Help buttons. Included in the Help system are feature 
descriptions and step-by-step procedures. 
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Uninstalling the Xerox Font Management Utility
To uninstall the Xerox Font Management Utility, use the Add/Remove Programs wizard in the Control 
Panel folder. If you have access to the CentreWare Print and Fax Services CD, you can modify and/or 
repair the Xerox Font Management Utility.

To uninstall the utility:
1 Using the appropriate path for your operating system, locate the list of printers:

Windows 2000 - Start > Settings > Control Panel > Add/Remove Programs 
Windows XP and Server 2003 - Start > Control Panel > Add or Remove Programs 
Windows Vista - Start button > Control Panel > Programs > Programs and Features > Uninstall 
a program 

The dialog for installing, changing, or uninstalling programs opens.

2 Select Xerox Font Management Utility.

3 Follow the procedures in the wizard to remove the Xerox Font Management Utility from your 
system.

To repair the utility:
With this option, you can fix missing or corrupt files, shortcuts, and registry entries.

1 Insert the CentreWare Print and Fax Services CD into the CD-ROM drive.

2 Click Management Services & Tools > Install Font Management Utility. The installation wizard 
opens. Click Next.

3 Select Repair. Click Next.

4 Click Install.

5 Click Finish to exit the wizard.
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Chapter 5
Installing the TIFF Submission Tool

With the TIFF Submission Tool, you can submit TIFF (Tagged Image File Format) and PDF (Portable 
Document Format) files directly to a Xerox system for printing. 
The primary advantage of this application is that it does not add additional PostScript information to the 
submitted file (often referred to as a PostScript wrapper). Instead, the TIFF or PDF files are submitted as 
print-ready files. This enables the Xerox system RIP (Raster Image Processor) to process TIFF and PDF 
files very quickly.

What’s in this chapter:

Workstation Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-2
Installing the TIFF Submission Tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-3
Accessing the TIFF Submission Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-3
Uninstalling the TIFF Submission Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-4
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Workstation Requirements
The TIFF Submission Tool can be used on workstations that meet the following basic requirements:

Windows 2000
Windows XP
Windows Vista
4 MB of hard drive space
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Installing the TIFF Submission Tool
Use the following procedure to install the TIFF Submission Tool software on a Windows workstation.

To install the TIFF Submission Tool:
1 Insert the CentreWare Print and Fax Services CD into the appropriate drive. The AutoRun program 

starts.

2 Click Tools and Utilities.

3 Click Install TIFF Submission Tool.

4 Click Next on the opening dialog of the installation wizard.

5 Read the Software License agreement and click Yes.

6 Enter your user and company information. Click Next.

7 Click Next on the Choose Destination Location dialog.

8 Click Next on the Select Program Folder dialog.

9 Click Finish. The CentreWare TIFF Submission Tool is ready for use.

Accessing the TIFF Submission Tool
To access the application on your PC:

From your desktop, select Start > Programs > Xerox CentreWare > CentreWare TIFF 
Submission Tool (Windows 2000) or Start > All Programs > Xerox CentreWare > CentreWare 
TIFF Submission Tool (Windows XP / Server 2003 / Vista).

Using the TIFF Submission Tool
The Help system is the primary source for information about using the TIFF Submission Tool. You can 
access the Help system through the Help buttons. Included in the Help system are feature descriptions 
and step-by-step procedures. 
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Uninstalling the TIFF Submission Tool
Use the following procedure to uninstall the TIFF Submission Tool software on a Windows workstation.

To uninstall the TIFF Submission Tool:
1 Using the appropriate path for your operating system, locate the list of printers:

Windows 2000 - Start > Settings > Control Panel > Add/Remove Programs 
Windows XP and Server 2003 - Start > Control Panel > Add or Remove Programs 
Windows Vista - Start button > Control Panel > Programs > Programs and Features > Uninstall 
a program 

The dialog for installing, changing, or uninstalling programs opens.

2 Follow the procedures in the application to remove the TIFF Submission Tool from your system.
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Chapter 6
 Problem Solving

Application, device, and network errors can occur in a variety of printing situations. In many cases, 
simply restarting the application, the workstation, or the printer will resolve the problem. This chapter 
includes some of the common problems and Frequently Asked Questions that pertain to CentreWare 
Printer Drivers and printing to your Xerox system.

What’s in this chapter:

Troubleshooting a Problem  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-2
Common Issues. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-3
Frequently Asked Questions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-6
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Troubleshooting a Problem
When a problem persists, document the error messages and gather information to define the problem. 
The following problem-solving procedures are recommended:

Accurately define the problem. When, where, and how does the problem occur?
Reproduce the problem. Can the problem be reproduced consistently or is it an intermittent problem?
Ask other users if they have encountered the problem, and keep a log to track problem occurrences. 
Examine the data for trends and the common attributes that may be related to the problem. For 
example, does the problem occur only with a specific printer or on a specific workstation/network 
configuration?
Review the product documentation, including the README files and problem solving topics, to see 
if any similar problems are documented. 

If a cause and solution to the problem cannot be identified, call the Xerox Welcome Center to report the 
error information. Provide the support representative with the documentation that you have gathered to 
define the problem.
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Common Issues
This section discusses some common application and printer driver functionality issues.

Adobe Acrobat Printing
All versions of Adobe Acrobat have exhibited various forms of distorted output when printing from a 
PCL driver. Stray lines, random character spacing, and data loss have been observed on various PDF 
documents. A CentreWare PostScript driver is recommended for printing Acrobat PDF files.

Booklet and Multiple-Up (N-Up) Printing
Some applications do not support booklet or N-up printing.  

Microsoft Word mail merge documents cannot be printed as booklets or N-up.
You may need to reset the Booklet or N-Up settings before you save your documents. Some 
applications, such as Microsoft Word 97, will save the scaling setting with the document. When the 
document is reopened later, the text and graphics may print in a reduced format unless you reset the 
N-Pages Up option on the printer driver Layout/Watermark tab to 1-Up prior to printing. It is 
generally best to reset this option to 1-Up before you save and close your documents.
N-up and booklet printing features may not work properly with Corel Draw version 8.
Use PCL Raster mode to print large N-Up/Booklet documents that do not print properly in Vector 
mode.

Euro Symbol
The Xerox Euro font family was created to support the imaging of the Euro currency symbol with fonts 
that do not yet support this character. The Xerox Euro font family consists of the Euro symbol in various 
styles and weights designed to work in conjunction with the most popular font styles. Many styles 
include a symbol at numeric width, which conforms to the standard design rules of the Euro symbol, as 
well as a designer version of the character, created to more closely resemble the original font. To use the 
symbol, set the font selection to Xerox Euro and type the keystroke that corresponds to the type style you 
are using. 

Xerox Euro Fonts are provided on the CentreWare Print and Fax Services CD within the 
...\Windows\Fonts folder.
Additional information and font installation instructions are available through the Internet on the 
Xerox Web site at www.xerox.com. 

If the fonts on your printer are not updated to include the Euro, a box will be printed instead of the 
Euro symbol. A workaround for this problem is to send Euro fonts to the printer as bitmapped 
images.
For PCL drivers, select the Always Send to Printer option in the CentreWare PCL driver when 
printing the Euro symbol. If problems persist when printing the Euro symbol, select the Send as 
Graphics option.

NOTE:  Free product updates for Windows 2000, enable users to input and display the Euro symbol 
in applications that are Euro symbol-enabled.
Common Issues 6-3
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PDF Printing
When printing a PDF, sending a large file may result in the printing of print limit check error sheets 
or only a banner sheet. If this occurs, print the PDF file using the PostScript printer driver or try 
printing the PDF file using LPR. 

Microsoft Applications

Excel

To change the job type options for any individual document, you must set the job type from within 
Microsoft Excel (Page Setup dialog). Job type changes for an individual document will not take 
effect if you invoke the CentreWare printer driver from the Printers folder.
Excel will generate multiple print jobs instead of multiple copies of a single document. This 
behavior can result in performance degradation, as well as inoperability of features, such as Sample 
Set, which depend on multiple set printing. In Excel, deselect the Collate option. This allows the 
driver settings to collate correctly. 
Excel may have occasional problems with documents that contain a mix of portrait and landscape 
pages. Selecting a different printer driver, then reselecting the original printer driver may help to 
resolve this problem.

PowerPoint

The Microsoft PowerPoint feature that optimizes black and white printing will produce undesired results 
when Raster output is selected as the Graphics Mode in the CentreWare PCL printer driver. Do not 
choose the black and white option in PowerPoint if Raster output is required.

Sample Set Not Supported in FrameMaker
Some applications generate print data that is intended for page printers rather than document printers, 
like the WorkCentre Pro and WorkCentre series. When the print data is sent in this format, both the 
WorkCentre Pro and the WorkCentre will print the first set of a Sample Set job, but the remaining sets of 
the document will be discarded. There is no known workaround for this problem.

Watermarks
The Watermark preview image in the printer drivers may not provide an exact replica of the printed 
watermark under all conditions. This is primarily due to font and/or resolution differences between the 
display monitor and the printer. Using equivalent TrueType fonts instead of printer resident fonts will 
help minimize the differences.
With some applications, the CentreWare PCL drivers may appear to print watermarks in the foreground 
even when the background printing option is selected in the driver. This is due to the different methods 
that applications use to send data to the printer. 

WordPerfect
If you encounter problems stapling multiple jobs as separate documents with WordPerfect 8.x, 
install the service pack available for WordPerfect at www.corel.com to correct the issue. 
Sample Set job types will not work with WordPerfect 8.x for Windows.
B4 JIS, B4 ISO, B6, and A6 paper sizes do not print with WordPerfect 8.x for Windows.  
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The scaling option in WordPerfect versions 7, 8, and 9 will override the Reduce/Enlarge option in 
the CentreWare drivers. Use the scaling option in the Print/Customize property sheet to adjust 
scaling rather than the CentreWare printer driver Reduce/Enlarge option.
With WordPerfect 6.1, the Playbill font may not print correctly when the Use Printer Fonts option is 
selected because the printer does not support the Playbill font.
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Frequently Asked Questions
How do I obtain printer drivers?
Printer drivers are available on the CentreWare Print and Fax Services CD or from the Xerox Web 
site at www.xerox.com. See Obtaining CentreWare Drivers on page 1-4 for more information.
How do I determine what printer driver is needed?
The following information is necessary to determine the correct printer driver:

Model of your Xerox system, for example, WorkCentre 5665 
Operating system environment, for example, Windows XP 
Type of printer driver, for example, PostScript or PCL
6-6 Problem Solving

http://www.xerox.com


Chapter 7
 Quick Reference Cards for Printer Drivers

Included in this chapter are Quick Reference Cards for your printer drivers. These cards may be printed 
separately from the rest of the User Guide and kept for reference. Note that each of these cards has two 
sides and is designed to be printed 2-sided.

What’s in this chapter:

Feature Facts Card—This single Quick Reference card describes selected printing options, such 
as Watermarks, Booklet Layout, and Stapling. 
Feature Finder Card —Two Quick Reference cards, one for PostScript and one for PCL, help 
you locate the many printing options available throught the printer driver to make printing 
easier. 
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Feature Facts >  WorkCentre Pro C2128 / C2636 / C3545Feature Facts >  WorkCentre Pro C2128 / C2636 / C3545Feature Facts >  WorkCentre 7328 / 7335 / 7345  

Printer driver 
 features that work for you.

Please note that the driver graphic is representative. Driver options 
and graphics will vary slightly depending on the operating system and 
model.

2000 / XP / Server 2003 / Vista
Negative Image
> Image Options Tab

The Negative Image 
option converts the black 
image areas in the origi-
nal to white, the white 
image areas to black, and 

any dark gray image areas to light gray. 
Printing a negative image may be use-
ful for documents that have a substan-
tial amount of dark background and / or 
light text and images (PostScript only).

Secure Print
> Paper/Output Tab > Job Type

 You can hold your docu-
ment for printing until you 
are ready to retrieve it at 
your Xerox system. First, 
select Secure Print from 

the Job Type list. Then click the 
Setup... button. Enter a secure print 
passcode in the dialog. After that, make 
any other selections from the printer 
driver and then send your document to 
the printer. Your document will be held 
at your Xerox system until you go to the 
printer and enter your passcode.

Saved Settings
> Bottom of All Tab Windows

 With some Xerox printer 
drivers, you can save all 
your chosen settings for a 
print job by clicking 
Save... from the Saved 
Settings group box.

When you need these settings again, 
click Load... from the Saved Settings 
group box and choose from the Job 
Settings drop-down list the name you 
gave your saved settings. The printer 
driver is updated with all your saved 
settings and you are ready to print.
Booklet Layout
> Layout/Watermark Tab

With the Booklet Layout 
option, you can print  
documents as small  
booklets. Two images are 
printed on both sides of 

each sheet of paper. The pages are reor-
dered sequentially and are oriented so 
that when folded, the paging is correct. 
You have the option, depending on the 
type of finisher you have installed, to 
have your booklet folded and stapled.
Fax 
> Configuration Tab

With the Fax feature, you 
can use the File > Print 
command in any applica-
tion to format and send 
FAX messages from any 

workstation on your network. Your Xerox 
system transmits your document from 
your workstation to its destination.  



Stapling
> Paper/Output Tab > Finishing

You can staple your 
documents with one or 
more staples, depend-
ing on the media size/
type and type of finisher 
you have installed.

1 Staple -  places a sta-
ple in the upper left cor-
ner for both Portrait or 
Landscape documents.

2 Staples -  places a 
second staple on the 
same side of the docu-
ment.

Booklet Creation - 
applies two staples 
along the fold to bind the 
booklet. 

Transparency Separators
> Paper/Output Tab > Paper

With this option, you can 
print separator pages 
between your transparen-
cies. Choose Select 
Paper, then Covers and 

Advanced... to make your transparency 
separator selections.

Mirror Image
> Image Options Tab

The Mirror Image option 
flips the page image from 
left to right, thereby 
reversing the image and 
all associated text. This is 

like turning over a printed transparency 
and viewing the back (PostScript only).
Accounting
> Configuration Tab

With CentreWare 
Accounting, you can track 
your Xerox system’s use 
by individual users and by 
account numbers. The 

accounting system collects and stores 
account information as jobs are 
submitted, making cost tracking and 
reporting an integral part of the print 
submission process. (Xerox Network 
Accounting is available for some 
WorkCentre models only.)

2-Sided Printing
> Paper/Output Tab

With 2-Sided Printing, you can print on 
both sides of a page. The available 
selections are:

1-Sided Print - prints on 
one side of a sheet of 
paper.

2-Sided Print - prints on 
both sides of a sheet of 
paper. To view the other 
side of the paper, turn the 
page over along the long-
est edge of the paper.

2-Sided Print, Flip on 
Short Edge - prints on 
both sides of a sheet of 
paper. To view the other 
side of the paper, you 

turn the page over along the shortest 
edge of the paper.

Fit to New Paper Size
> Layout/Watermark Tab

The Fit to New Paper Size 
feature enables you to 
resize a document page to 
fit onto a different size 
media while retaining the 
look and formatting of the 

original document.

 f
Banner Sheet
> Advanced Tab > Paper/Output

A Banner Sheet is an 
additional separator page 
that is printed with your 
jobs. The banner sheet 
includes the Xerox system 

device name and your network user 
name. Banner sheets separate each 
completed print job in the output bins, 
making it easier to identify and retrieve 
your documents when they are among 
documents that have been submitted by 
other network users.

Save to Mailbox
>Paper/Output Tab > Job Type

With Save to Mailbox, you 
can stores the job on the 
printer hard drive so that it 
can then be printed on 
demand from the printer 

control panel or printed from Centre-
Ware Internet Services. When you select 
this job type, the Save to Mailbox dialog 
box appears so you can assign a job 
name and, if desired, print it and save it. 

Watermark
> Layout/Watermark Tab

With the Watermark option, 
you can create and print 
foreground / background 
text on the first page or 
every page of a document. 
The watermark definitions 

you create can be used on any docu-
ment. 

Some Xerox printer drivers support bit-
map watermarks. You can select, scale, 
and position a graphic bitmap for use as 
a watermark.

N-Up Printing
> Layout/Watermark Tab > Pages Per 
Sheet (N-Up)

Multiple-Up (N-Up) printing 
is used to print more than 
one page of a document on 
a single page. You can 
print 2, 4, 6, 9, or 16 

images (pages) on one side of a sheet of 
paper. 
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